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Intisari 
 

Perkembangan zaman yang semakin modern, terutama perkembangan di bidang 
pembangunan industri, baik itu di bidang oil & gas plant, petrochemical plant dan power plant 
sangat membutuhkan teknologi yang dapat mempermudah perancangan suatu general plant. 
Perancangan menggunakan software memungkinkan untuk dilakukan simulasi pemodelan sebelum 
sebuah kontruksi perpipaan dimulai. Hal ini akan mempercepat tahap kontruksi dan meminimalisir 
terjadinya kesalahan desain. Software SmartPlant 3D (SP3D) merupakan salah satu aplikasi yang 
dapat digunakan dalam proses pemodelan suatu general plant.  

Data pemodelan dengan menggunakan software SP3D yaitu gambar 2D meliputi 
equipment, P&ID, general plant, equipment location, dan piping isometric. Setelah melakukan 

pemodelan maka langkah selanjutnya yaitu menentukan berat komponen sistem perpipaan, rangka 
dan equipment. Berat komponen sistem perpipaan dan equipment dapat diketahui menggunakan 
aplikasi Pipedata-Pro versi 12.1.09. 

Hasil pemodelan menggunakan software SmartPlant 3D (SP3D) versi 2014 R1 yaitu 
gambar 2D dan 3D equipment meliputi equipment D1201 reflux drum, C1101 cracking tower, 
E1301 reboiler, E1302A/B stabilizer reflux condenser, P1501A/B reflux pumps, P1502A/B over 
head produck pumps, sedangkan pemodelan pipa menghasilkan gambar 3D dan isometric pipa 
yang meliputi pipa 100-B-A3B-1, 100-B-A3B-2, 150-A-A1A-3, 200-B-A3B-4, 250-B-A3B-5, 150-B-
A3B-6, 80-B-A3B-7, 100-B-A3B-8, 50-B-A3B-9, 40-B-A3B-10, 80-A-A1A-11, 100-C-F1C-12, 100-C-
F1C-13, 150-A-A1A-57. Hasil reports lain dari SP3D berupa material take-off (MTO) meliputi 
komponen piping, fittings, valves, flanges, bolts dan gasket. Adapun total hasil perhitungan berat 
meliputi berat komponen perpipaan, berat rangka dan berat equipment yaitu 60.303,42 kg 

 
 
Kata kunci : Pemodelan, Software SmartPlant 3D (SP3D) versi 2014 R1, Equipment, 

Piping, General Plant 
 

  
 

1. PENDAHULUAN  

  
Perkembangan zaman yang semakin modern, terutama perkembangan di bidang 

pembangunan industri, baik itu di bidang oil & gas plant, petrochemical plant dan power 
plant sangat membutuhkan teknologi yang dapat mempermudah perancangan suatu 
general plant. Perancangan menggunakan software memungkiknkan untuk dilakukan 
simulasi pemodelan sebelum sebuah kontruksi perpipaan dimulai. Hal ini akan 
mempercepat tahap kontruksi dan meminimalisir terjadinya kesalahan desain. 
Perancangan sistem perpipaan yang baik dan aman sangat dibutuhkan untuk menjamin 
kelangsungan dari proses serta menjamin umur pemakaian dari sistem pemipaan sesuai 
dengan siklus rancangan (Prityatama dkk, 2014). Software SmartPlant 3D (SP3D) 
merupakan salah satu aplikasi yang dapat digunakan dalam proses pemodelan suatu 
general plant.  



JMPM: Jurnal Material dan Proses Manufaktur - Vol.XXX, No.XXX, XXX  
http://journal.umy.ac.id/index.php/jmpm 

 
                                                                                                                                                                                                                          

JMPM | Jurnal Material dan Proses Manufaktur 2 

 

Dengan digunakannya software SP3D ini, maka perancangan suatu plant akan 
lebih mudah dilakukan karena dalam prosesnya sudah dalam bentuk 3D. Dengan 
berbasis 3D maka kesalahan desain dalam proses pendesainan akan lebih mudah dalam 
penanganan tanpa harus melakukan desain ulang. Selain kemudahan dalam proses 
perancangan yang berbasis 3D, efisien waktu dan report yang dihasilkan merupakan 
point penting dalam suatu perancangan. Kelebihan lain yang ditawarkan software SP3D 
yaitu dapat berinteraksi dengan software sejenis seperti MikroStation, AutoCAD, 
Worksheet, Caesar dan bahkan dapat memanfaatkan keunikan yang terdapat pada Excel 
sehingga dapat mempermudah dalam perancangan suatu desain.  

Proses pembuatan 3D modeling structure maupun equipment dapat berlangsung 
dengan baik karena dalam proses pendesainannya, SP3D dapat memberikan masukan 
yang tepat dan akurat sesuai dengan plot plan yang ada, sehingga meminimalisir 
kesalahan desain. Selain itu output dari pemodelan piping berbasis SP3D dapat 
menghasilkan piping drawing isometric dengan otomatis dan akurasi tinggi. Oleh karena 
itu penggunaan SmartPlant 3D tidak hanya mudah dalam proses perancangan akan 
tetapi output yang dihasilkan dapat memberikan informasi penting dan akurat terkait 
proyek yang dikerjakan. Dengan segala kelebihan yang ditawarkan software SmartPlant 
3D (SP3D) maka akan membantu seorang desainer dalam meyelesaikan pekerjaannya. 

 
 

2. METODE PEMODELAN  

Dalam mendesain suatu project menggunakan software SP3D, terdapat tahapan-
tahapannya sehingga akan menghasilkan output yang sesuai dari perencanaan 
sebelumnya, dapat dilakukan sesuai dengan diagram alir yang dapat dilihat pada 
Gambar 1 berikut. 
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Gambar 1 Diagram alir pemodelan menggunakan software SP3D. 
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3. PROSES PEMODELAN SP3D 

Langkah pertama yang dilakukan untuk mengoperasikan aplikasi SP3D yaitu 
dengan cara Start > All Programs > Intergraph Smart 3D > Smart 3D. Gambar 2 berikut 
menunjukkan cara untuk login aplikasi SP3D. 

 
Gambar 2. Login aplikasi SP3D. 

 
 Setelah login aplikasi SP3D, selanjutnya pilih Metric Unit. Gambar 3 berikut 
menunjukkan pemilihan unit SP3D. 

 
Gambar 3. Pemilihan unit SP3D. 

 
Sebelum melakukan pemodelan menggunakan software SP3D, terlebih dahulu 

membuat hierarchy sebagai susunan/penataan desain yang nantinya akan muncul pada 
kolom workspace explorer. 

Langkah pertama dalam pembuatan hierarchy yaitu dengan memfilter hierarchy. 
Pilih File > Define Workspace. Setelah itu muncul Define Workspace. Dalam pembuatan 
hierarchy baru maka langkah selanjutnya yaitu pilih Filter > Create New Filter. Gambar 4 
berikut menunjukkan tampilan create new filter pada define workspace. 

 
Gambar 4. Create new filter pada define workspace. 

 
Setelah itu akan muncul new filter properties. Dalam new filter properties ini belum 

ada hiearachy yang dibuat atau masih bawaan/sample dari SP3D. Untuk membuat 
hierarchy sendiri sebelumnya edit kolom Name, isikan TM UMY. Untuk membuat 
hierarchy area baru, terlebih dahulu memilih area bawaan/sample dari SP3D sebagai 
langkah awal membuat hierarchy area sendiri. Gambar 5 berikut menunjukkan tampilan 
new filter properties. 
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Gambar 5. New filter properties. 

 
Setelah pilih oke maka akan kembali ke define workspace. Lalu pilih oke pada 

define workspace. Setelah itu akan muncul A1 pada workspace explorer yang merupakan 
hierarchy sample dari SP3D sebagai acuan/dasar untuk membuat hierarchy sendiri 
secara manual. Untuk membuat hierarchy sendiri secara manual yaitu dengan pilih Task 
> Systems and Specifications. . 

Setelah itu akan muncul systems and specifications. Dalam systems and 
specifications akan muncul area yang merupakan bawaan dari SP3D. Untuk membuat 
area baru, langkah awal yaitu pastikan hierarchy pada projecknya yaitu SP3D Train. 
Kemudian pilih create other system pada tool bar lalu pilih new area system. Gambar 6 
berikut menunjukkan cara pembuatan new area system. 

 
Gambar 6. Pembuatan new area system. 

 
 Setelah itu muncul hierarchy baru yaitu Area System-1-1101. Kemudian rename 
area system-1-1101 menjadi PROJECT BARU. Langkah selanjutnya yaitu membuat unit 
system yang berada di bawah PROJECT BARU. Caranya yaitu pastikan hierarchy pada 
PROJECT BARU. Kemudian pilih create other system pada tool bar. Lalu pilih New Unit 
System. Setelah itu rename unit system-1-1102 menjadi unit 01.  

Setelah membuat unit area baru, selanjutnya create disiplin sesuai dengan kasus 
yang akan dikerjakan yaitu EQUIPMENT, STRUCTURE & PIPING. Caranya yaitu 
pastikan hierarchy pada unit 01. Lalu pilih create other system pada tool bar, lalu pilih 
new equipment system. Kemudian rename equipment system 1-1101 menjadi 
EQUIPMENT. 
 Pembuatan disiplin selanjutnya yaitu STRUCTURE & PIPING, caranya sama 
dengan pembuatan disiplin EQUIPMENT. Gambar 7 berikut menunjukkan tampilan hasil 
pembuatan disiplin equipment, piping dan structure. 

 
Gambar 7. Hasil pembuatan disiplin equipment, piping dan structure. 
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Setelah hierarchy tersusun, langkah selanjutnya yaitu kembali ke task normal. 
Caranya yaitu pilih Tasks > Common. Setelah kembali ke task normal maka akan muncul 
dua area pada workspace explorer yaitu A1 dan PROJECT BARU seperti pada Gambar 
8 berikut. 

 
Gambar 8. Tampilan workspace explorer. 

 
Langkah selanjutnya yaitu filter ulang area, karena area yang dibutuhkan hanya 

PROJECT BARU. Caranya yaitu klik File > Define Workcpace. Pastikan kolom Filter 
pada TA BARU2 > Properties > PROJECT BARU. Kemudian klik ok.  

Setelah filter ulang, maka area yang muncul pada workspace explorer hanya 
PROJECT BARU, seperti pada Gambar 9 berikut. 

 
Gambar 9. Tampilan workspace explorer baru. 

 
3.1 Pemodelan Equipment D1201 (Stabilizer Reflux Drum) 

Sebelum melakukan pemodelan equipment, perlu diperhatikan bahwa posisi task  
harus sudah pada posisi equipment and furnishing. Equipment D1201 terdiri dari 
beberapa bentuk yaitu : Head (2buah), Cylinder (1 buah), Foundation (2buah) dan Nozzle 
(8 buah). Adapun langkah-langkah dalam pemodelan D1201 yaitu sebagai berikut : 

 
3.2 Pembuatan hierarchy equipment D1201.  

 Pada tool design pilih place design equipment. Selanjutnya pilih horizontal drum 
with Saddle. Setelah itu akan muncul design equipment properties.  Isikan nama = 
D1201, system = EQUIPMENT, lalu pilih oke. 
Gambar 10 berikut menunjukkan tampilan design equipment properties. 

 
Gambar 10. Tampilan design equipment properties. 
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Setelah itu pada menu bar pilih pin point untuk memasukkan nilai koordinat 
sesuai dengan yang ada pada plot plan yaitu north (N) = 294502 mm, east (E) = -312370 
mm ; (-) menunjukkan posisi pada arah west, elevation (El) = +106170 mm. Kemudian 
klik kanan sembarang tempat. 

Di dalam hierarchy equipment D1201 terdiri dari 3 sub-equipment yaitu BODY, 
DATUM, dan NOZZLE.  

 
3.2.1. Pembuatan sub-equipment BODY D210. 

Langkah awal pembuatan sub-equipment BODY yaitu klik hierarchy 
equipment D1201, kemudian pilih place design equipment component pada tool design. 
Selanjutnya pilih horizontal drum seperti pada Gambar 11 berikut. 

       
Gambar 11. Pembuatan sub-equipment BODY D1201. 

 
Kemudian diminta untuk memasukkan nilai kooordinat. Nilai koordinat BODY 

D1201 sama dengan koordinat hierarchy D2101. 
 

3.2.2. Pembuatan sub-equipment NOZZLE D1201 
Langkah dalam pembuatan sub-equipment NOZZLE D1201 yaitu klik 

hierarchy D1201, kemudian pilih place design equipment component pada tool design. 
Selanjutnya pilih manway davit vertical cover seperti pada Gambar 12 berikut. 

         
Gambar 12. Pembuatan sub-equipment NOZZLE D1201. 

 
Kemudian diminta untuk memasukkan nilai kooordinat. Nilai koordinat 

NOZZLE D1201 sama dengan koordinat hierarchy D2101. 
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3.2.3. Pembuatan sub-equipment DATUM D1201 
Pembuatan sub-equipment datum D210 yaitu dengan klik hierarchy D1201, 

kemudian pilih shapes pada tool design, seperti pada Gambar 13 berikut. 

 
Gambar 13. Pembuatan sub-equipment DATUM D1201. 

 
Kemudian masukkan nilai koordinat yang nilainya sama dengan nilai koordinat 

hierarchy D1201. Rotate DATUM D1201 dengan axis direction N/S masukkan -90 
derajat. Jangan lupa klik fast rotate. Kemudian pilih close.  

 
3.3. Proses Pemodelan Equipment D1201 

Setelah selesai membuat sub-equipment BODY, NOZZLE, dan DATUM, langkah 
selanjutnya yaitu pemodelan equipment D1201. Adapun langkah-langkahnya sebagai 
berikut. 

1) Pastikan klik terlih dahulu sub-equipment BODY D1201. Kemudian pilih circular 
cylinder pada menu shapes yang ada pada tool design. Selanjutnya isikan name 
= CYLINDER, A = 4800 mm, B = 1410 mm. Kemudian pilih ok. Setelah itu 
masukkan koordinat sementara yaitu N = 0, E = 0, El = 0. Lalu klik sembarang 
tempat. Rotate CYLINDER D1201 dengan axis direction up/down sebesar 90 
derajat. Jangan lupa pilih close. Gambar 14 berikut menunjukkan hasil 3D 
pemodelan cylinder. 

 
Gambar 14. Hasil 3D pemodelan cylinder. 

 
2) Head dibuat pada kedua ujungnya yaitu berupa semi elliptical head. Pastikan 

pilih sub-equipment BODY D1201 kemudian pilih semi elliptical head pada menu 
shapes. Selanjutnya isikan name = HEAD, A = 1410 mm, B = 380 mm. Kemudian 
pilih oke. Setelah itu masukkan koordinat sementara E = 0, N = 0, El = 0. Rotate 
HEAD dengan axis direction up/down sebesar -90 derajat. Lalu pilih close. 
Gambar 15 berikut menunjukkan hasil 3D pemodelan head 1. 
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Gambar 15. Hasil 3D pemodelan head 1. 

 
Setelah selesai membuat head pertama, selanjutnya untuk head kedua 

caranya sama dengan head pertama hanya untuk koordinatnya E = 0, N = 4800, 
El = 0. Lalu rotate dengan axis direction up/down debesar 90 derajat lalu tekan 
close. Gambar 16 berikut menunjukkan hasil 3D pemodelan head 2. 

 
Gambar 16. Hasil 3D pemodelan head 2. 

 
3) FOUNDATION dibuat dengan memilih rectangular solid pada menu shapes. 

Kemudian Isikan name = FOUNDATION 1,  A = 1060 mm, B = 300 mm, C = 950 
mm. Kemudian pilih oke. Selanjutnya masukkan koordinatnya yaitu E = -530 mm, 
N = 965 mm, El = -430 mm. Untuk FOUNDATION  kedua caranya sama dengan 
FOUNDATION  pertama hanya untuk koordinatnya E = -530 mm, N = 3835 mm, 
El = -430 mm. Gambar 17 berikut menunjukkan hasil 3D pemodelan 2 
foundations 

 
Gambar 17. Hasil 3D pemodelan foundations, head dan cylinder. 

 
4) Pembuatan nozzle. Sebelum pemodelan nozzle dimulai, terlebih dahulu 

membuat DATUM NOZZLE. Pastikan hierarchy pada sub-equipment NOZZLE 
D1201 kemudian pilih datum pada menu shapes. Masukkan koordinat DATUM 
NOZZLE yaitu N = 0, E = 0, El = 0. Kemudian rotate dengan axis direction 
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up/down sebesar 90 derajat. Lalu pilih close. Equipment D1201 terdiri dari I buah 
manhole dan 7 nozzle. Berikut ini merupakan input data yang dimasukkan untuk 
nozzle equipment D1201 sebagai contoh Manhole  (M1). Langkah pertama klik 
DATUM NOZZLE, kemudian pilih place nozzle pada tool design. Kemudianubah 
name = M1, nominal size = 450 mm, pressure rating = #300 RF, nozzle length = 
610 mm, placement type = axial, N1 = -610 mm, N2 = 0, OR = 0 derajat. Setelah 
itu pilih oke. Gambar 18 berikut menunjukkan tampilan nozzle properties untuk 
manhole. 

   
Gambar 18. Nozzle properties untuk manhole. 

 
Untuk input data nozzle yang lain tinggal mengubah spesifikasi sesuai dengan 
data yang ada di gambar 2D. 
 
Gambar 19 berikut menunjukkan hasil 3D pemodelan equipment D1201 yang 
terdiri dari beberapa bentuk yaitu : Head (2buah), Cylinder (1 buah), Foundation 
(2buah) dan Nozzle (8 buah). 

 
Gambar 19. Hasil 3D pemodelan equipment D1201. 

 
Setelah selesai melakukan pemodelan BODY D1201 berupa 1 buah cylinder, 2 

buah head  dan 8 buah nozzle maka langkah selanjutnya yaitu memindahkan koordinat 
equipment D1201 ke koordinat asli sesuai dengan plot plan. Caranya yaitu select under  
BODY D1201 dan under DATUM D1201 seperti pada Gambar 20 berikut. 

 
Gambar 20. Pemilihan hierarchy equipment D1201. 
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Setelah itu pilih move pada menu toolbar. Pilih titik awal pemindahan yaitu 

nozzle 1 (N1). selanjutnya masukka nilai koordinat asli/sesuai dengan yang ada pada plot 
plan yaitu E = -312370 mm, N = 295010 mm, El = 106970 mm. Jangan lupa centang fast 
move. Lalu klik kanan sembarang tempat. Gambar 21 berikut menunjukkan pemindahan 
equipment D1201 ke koordinat sebenarnya. 

 
Gambar 21 Pemindahan equipment D1201 ke koordinat sebenarnya. 

 
Setelah selesai melakukan pemodelan equipment D1201, maka dapat 

dilanjutkan melakukan pemodelan equipment yang lain dengan cara yang hampir sama. 
 

3.4. Pemodelan pipa 250-B-A3B-5 
Dari gambar P&ID dapat diketahui bahwa pipa 80-B-A3B-7 merupakan pipa yang 

menghubungkan antara nozzle N2 pada equipment E1302A menuju nozzle N1 pada 
equipment D1201. Adapun maksud dari pipa 80-B-A3B-7 adalah: 

- 80 = Ukuran pipa dalam milimeter (mm) 
- B = Service, B = Brine 
- A3B = Pipe Specification 
- 7 = Sequence number 

Sebelum melakukan pemodelan jalur pipa 80-B-A3B-7, maka terlebih dahulu 
membuat hierarchy line number yaitu dengan klik kanan pada hierarchy piping > new 
system > new pipeline. Setelah itu muncul property pages dialog dan isikan nama 80-B-
A3B-7 seperti pada Gambar 22 berikut. 

 
Gambar 22 Property pages dialog pipa 80-B-A3B-7. 

 
Setelah selesai membuat hierarchy line number maka selanjutnya routing pipa. 

Caranya yaitu : 
- Pilih route pipe pada tool design. 
- Tentukan titik awal dimana routing pipa dimulai yaitu N2 pada equipment 

E1302A. 
 

Gambar 23 berikut menunjukkan Penentuan titik awal routing pipa pada N2 equipment 
C1101. 
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Gambar 23.Penentuan titik awal routing pipa pada N2 equipment E1302A. 

 
Setelah menentukan titik awal dimana routing pipa dimulai, selanjutnya muncul 

tabel new pipe run seperti pada Gambar 24. Isikan data sebagai berikut : 
- Posisi pipeline pada hierarchy 80-B-A3B-7 
- Nama = PIPE RUN 1. 
- Untuk ukuran diameter menyesuaikan dengan ukuran nozzle.  
- Setelah itu tekan ok. 

 
Gambar 24 New pipe run 1. 

 
Pipa 80-B-A3B merupakan pipa lurus, jadi setelah menentukan tiitk awal dimana 

routing pipa dimulai maka langkah selanjutnya yaitu arahkan cursor menuju nozzle N1 
pada equipment D1201seperti pada Gambar 25. Jangan lupa klik kiri pada posisi nozzle 
N1.  

  
(a) (b) 

Gambar 25. (a) Penentuan titik akhir pipa, (b) Hasil 3D pemodelan pipa 80-B-A3B-7. 
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4. PEMBAHASAN 

Setelah melakukan pemodelan menggunakan software SP3D maka didapat hasil 
pemodelan berupa gambar 2D dan 3D meliputi equipment, piping dan general plant.  

 
1. Equipment D1201 2. Equipment E1301 

  
Gambar 26. Hasil pemodelan 3D 

equipment D1201 
Gambar 27. Hasil pemodelan 3D 

equipment E1301 
  
  

3. Equipment E1302A 4. Equipment E1302B 

 
 

Gambar 28. Hasil pemodelan 3D 
equipment E1302A 

Gambar 29. Hasil pemodelan 3D 
equipment E1302B 

  
  

5. Equipment P1501A/B 6. Equipment P1502A/B 

 
 

Gambar 30. Hasil pemodelan 3D 
equipment P1502A/B 

Gambar 31. Hasil pemodelan 3D 
equipment P1502A/B 

  

  
  



JMPM: Jurnal Material dan Proses Manufaktur - Vol.XXX, No.XXX, XXX  
http://journal.umy.ac.id/index.php/jmpm 

 
                                                                                                                                                                                                                          

JMPM | Jurnal Material dan Proses Manufaktur 14 

 

7. Pipa 80-B-A3B-14 8. Pipa 250-B-A3B-5 

  

Gambar 32. Hasil pemodelan 3D pipa 
 80-B-A3B-14 

Gambar 33. Hasil pemodelan 3D pipa 
250-B-A3B-5 

  
  

9. Gambar 3D General Plant 

 
Gambar 34. Hasil 3D pemodelan general plant. 
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10. Gambar 2D equipment D1201. 

 
Gambar 35. Hasil pemodelan 2D equipment D1201. 

 
 

11. Gambar isometric pipa 100-B-A3B-8 

 
Gambar 36. Hasil pemodelan isometric pipa 100-B-A3B-8 
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 Setelah melakukan pemodelan, maka dilakukan perhitungan berat komponen 
perpipaan, rangka dan equipment. Hasil perhitungan dapat dilihat pada tabel-tabel 
berikut. 
 

Tabel 1. Hasil perhitungan berat komponen perpipaan. 

 Kategori Quantity 
Berat 
(kg) 

1. Piping 273,535 meter 4.767,5  

2. Fittings 125 buah 621,85  

3. Flanges 88 buah 834,44  

4. Valve 35 buah 1.154  

5. Bolts 580 buah 164,33  

6. Gasket  85 buah 17,51  

  Total berat 7.559,63  

 
 

Tabel 2. Hasil perhitungan berat rangka (piperack). 

Item Tipe section 
Tipe 

material 
Material 
grade 

Panjang 
Berat 
(kg) 

1. Beam  HP10×42 Carbon steel A 153,19 m 9.575,08  

2. Column  HP10×42 Carbon steel A 136,18 8.511,37  

3. Brace  HP10×42 Carbon steel A 34,2 m 2.137,82  

     Total 
berat 

20.224,27  

 
 

Tabel 3. Hasil perhitungan berat equipment. 

 E1301 D1201 E1302A E1302B C1101 
Total 
berat 
(kg) 

Shell (kg) 1.534,57 2.873,02 477,9 477,9 11.495,62 16.859,01 

Head 

Ellipsoidal 
(Kg) 

230,24 728,51 23,31 23,31 175,09 1.180,46 

Cone (kg) 0 0 0 0 180,86 180,46 

Nozzle (kg) 152,11 244,32 62,96 79,72 773,99 1.313,1 

Tubesheet 
(kg) 

1.017,36 0 300,26 300,26 0 1.617,88 

Plate (kg) 0 0 0 0 10.597,5 10.597,5 

Saddle + 
plate aus 
(kg) 

111,47 301,44 438,98 219,49 0 1.071,38 

     
Total berat 
equipment 

32.820,19 
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5. KESIMPULAN 

Dari hasil pemodelan menggunakan aplikasi atau software SP3D dapat dibuat 
kesimpulan sebagai berikut: 

1. Dari dokumen PDMS training project SAM001 didapat hasil pemodelan 
equipment 2D dan 3D yang meliputi : reflux drum D1201, reboiler  E1301, 
cracking tower C1101, stabilizer reflux condenser E1302A, stabilizer reflux 
condenser E1302B, reflux pump P1501A, reflux pump P1501B, overhead 
produck pump P1502A, overhead produck pump P1502B. 

2. Dari dokumen PDMS training project SAM001 didapat hasil pemodelan pipa yang 
terdiri dari gambar 3D dan piping isometric meliputi : 100-B-A3B-1, 100-B-A3B-2, 
150-A-A1A-3, 200-B-A3B-4, 250-B-A3B-5, 150-B-A3B-6, 80-B-A3B-7, 100-B-
A3B-8, 50-B-A3B-9, 40-B-A3B-10, 80-A-A1A-11, 100-C-F1C-12, 100-C-F1C-13, 
150-A-A1A-57. 

3. Hasil pemodelan general site view, equipment location, dan pipe layout 
merupakan hasil pemodelan 2D yang merupakan output dari drawing console 
software SP3D. 

4. Hasil reports dari SP3D berupa material take-off (MTO) yang menampilkan jenis 
komponen, diskripsi komponen, ukuran komponen, jumlah komponen dan 
panjang komponen yang digunakan dalam jalur perpipaan. Contohnya komponen 
jenis fitting mempunyai diskripsi yaitu 45 deg LR elbow, S-STD, BE, ASTM-A234-
WPB, ASME-B16.9 berukuran 4 in dan jumlah 1. 

5. Setelah melakukan perhitungan berat equipment selain pompa/equipment dari 
vendor dan komponen perpipaan didapat berat total yaitu : 
Berat total equipment selain pompa/equipment dari vendor : 32.820,19 kg 
Berat total komponen sistem perpipaan    : 7.559,63 kg 
Berat total rangka      : 20.224,27 kg 
Dari masing-masing total berat di atas apabila diakumulasikan maka akan 
didapat total berat 60.604.09 kg. 
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